
 
Vectorworks 

for 
Garden Designers 

 
 
 
 
 
 

Part I 
 

Introduction to Vectorworks 
 
 
 
 
 
 
 
 
 
Oxford College of Garden Design 
© Notes copyright Jenny Woods, 2004 



 2

Contents 
 
 
 
1 Introduction to the Vectorworks Interface .....................................................................3 

1.1 A few initial discussion points............................................................................................ 3 
1.2 What am I looking at?........................................................................................................ 3 
1.3 File naming conventions.................................................................................................... 4 
1.4 Paper sizes and drawing to scale...................................................................................... 5 
1.5 Saving Templates.............................................................................................................. 7 

 
2 Simple Drawing Techniques .........................................................................................8 

2.1 Handy Hints....................................................................................................................... 8 
2.2 Drawing a simple shape.................................................................................................... 8 
2.3 Changing views................................................................................................................. 8 
2.4 Copying and Pasting ......................................................................................................... 9 
2.5 Multiple ways of drawing a shape ..................................................................................... 9 
2.6 Selecting a shape or shapes............................................................................................. 9 
2.7 Straight lines defined by XY (Cartesian) co-ordinates or LA (polar) co-ordinates............. 9 
2.8 Drawing curved lines ......................................................................................................... 9 
2.9 Moving, grouping and rotating shapes .............................................................................. 9 
2.10 Changing colours, line styles and simple fills .................................................................. 10 

 
3 Aligning Objects Accurately and Building Complex Shapes .......................................11 

3.1 Using Constraints ............................................................................................................ 11 
3.2 Building more complex shapes ....................................................................................... 13 

 
4 Drawing Real Structures.............................................................................................15 

4.1 Use of the duplicate array function.................................................................................. 15 
4.2 Duplicating using circular array and the offset and trim tools.......................................... 17 
4.3 Duplicating an object along a path .................................................................................. 18 

 
5 Filling in diagrams and using resources......................................................................20 

5.1 Material fill ....................................................................................................................... 20 
5.2 Simple Patterns ............................................................................................................... 21 
5.3 Using Symbols and the Resource Browser..................................................................... 21 
5.4 Hatches ........................................................................................................................... 22 
5.5 Editing Hatches ............................................................................................................... 23 

 
6 Adding technical details ..............................................................................................26 

6.1 Dimensioning linear objects ............................................................................................ 26 
6.2 Dimensioning circles and angles..................................................................................... 28 

 
7 Presentation of Drawings............................................................................................29 

7.1 Labelling diagrams .......................................................................................................... 29 
7.2 Borders and Title Blocks ................................................................................................. 29 
7.3 Layers.............................................................................................................................. 30 

 
 
 
 



 3

1 Introduction to the Vectorworks Interface 
 
Start up Vectorworks by double-clicking on the icon. 
 
The application may seem very slow to start – don’t panic, this is usual! 

1.1 A few initial discussion points 
 
Usually Vectorworks uses a dongle to prevent piracy, although it is possible to buy a multi-user 
package.  
 
When Vectorworks installs it does not create an icon – one has been set up for the training 
session, but you won’t see it on your home computer, unless you make one yourself! 
 
Apparently Vectorworks, like some Microsoft applications, suffers from a memory leak problem. If 
the application starts slowing down, save work, close the application and re-start. 
 
Vectorworks prompts for an automatic save every 15 minutes with a pop-up screen (as below). It’s 
important to save work in progress, but if you’re just playing say “no” to the save. 
 
 
 
 
 
 
 
 

1.2 What am I looking at? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you start the application, this is what you see. 
 
 

In common with other Windows applications, there is a Window title bar and a Menu bar. 
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Note that the “Help” menu brings up a PDF document which can be read in Adobe (if installed!), 
not a searchable system as with Microsoft applications. 
 
The screen seen on start up is known as the “Workspace”. Workspace set-ups are predefined by 
Vectorworks and can be accessed from the “File” menu. We will use this one for the course, known 
as the “Architect” workspace.  
 
Look under “File”, “Workspaces” to see the range available – try selecting a few to see how the 
workspace changes, then set back to the “Architect” workspace. 
 
Down the LHS are a range of strange shapes – these are the drawing tools belonging to various 
palettes which will be gone into in detail during the course.  
 
Moving your cursor over the tools brings up their names and right-clicking on them brings up other 
similar tools to select from. Have a look to become familiar with their names. 
 
The main white space of the window represents a piece of paper on a drawing board. Note that it is 
possible to draw beyond the boundaries of the paper!  
 
You can change how the page is displayed through the “Page” menu. Click on “Page”, “Fit to 
Window” and “Page”, “Normal Scale” to see this. (Normal Scale will depend on the scales chosen 
which will be covered soon) 
 
It is possible to build up drawings in “Layers” in the same way that you might stick layers of tracing 
paper on top of each other on your drawing board. We will look at this in more detail at the end of 
this course – for the time being we will work with one layer. 
 
The position of the cursor on the paper is defined by XY (Cartesian) and LA (polar - length, angle) 
co-ordinates displayed in boxes underneath the drop-down menus. The zero of the co-ordinates is 
defined as the centre of the paper. 
 
Move the cursor around to see how these numbers change. 
 
At the top right is a section headed Object Info – which will give details about selected objects 
(lines, circles etc.) once they are drawn. 
 
At the bottom right is a section labelled Resource Browser which will be used to show which files 
and other resources are being used for a particular project. We will talk about this in more detail 
later – in the meantime don’t worry if odd stuff appears in here! 
 
These last two sections are also palettes. All the palettes can be accessed and turned on and off 
through the menus.  
 
Click on “Windows” then “Palettes” to see which palettes are turned on at present – you should see 
the 2D tools (the shapes down the LHS), the resource browser and the object information. 

1.3 File naming conventions 
By default Vectorworks wants to save files in C:Program files/Vectorworks 10.5 
 
For this course we have created a directory C:My Documents/Vectorworks Files to prevent 
students writing over anything in the program structure! 
 
Vectorworks drawings are saved with the file extension *.mcd 
 
Save this file now as First Example.mcd in the C:My Documents/Vectorworks Files directory. 
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1.4 Paper sizes and drawing to scale 
Let’s start by defining the size of paper we want to draw on. Click “File”, “Setup”, “Document Setup”  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on change next to Drawing Area – a pop-up appears.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
By default this version of Vectorworks is set to American page sizes and units, so we need to set it 
to metric. 
 
Select ISO A4 from the “Size” drop list. Select mm instead of inch. Select show page breaks, then 
click OK.  
Note that Vectorworks default setup for the page is landscape – if you want portrait you will have to 
select “other” from the size droplist and manually enter 210 and 297mm for the page dimensions. 
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(If the page breaks appear across the middle of the paper it is because your printer is set to 
portrait. This can be corrected through “File”, “Print Set-up”)  
 
The units shown on the page can be set to millimetres by clicking on “Change” next to drawing 
units and selecting millimeters from the Unit Name drop list on the pop-up screen as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Check that all other boxes are set as above  
Using a grid can help in the placement of drawn objects. The grid is only seen if you zoom in close. 
Set the snap grid to 1 and the reference grid to 10 (remember units are millimetres). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finally we can define the scale of our drawing. 
 
Select “Layer scale”, “Change” – the following pop-up appears. 
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We want to work in metric at a scale of 1:50, so select the correct button and click OK.  
 
As we’re only working with one layer we won’t select anything else at the moment.  
 
Now note that the XY position of the cursor in the workspace is shown at the 1:50 scale, i.e. the 
scale of the object we are going to draw, not the paper sizing. 

1.5 Saving Templates 
This is a useful set-up, so to prevent having to do all this every time we start a picture it can be 
saved as a template.  
 
Click “File”, “Save as template” – note a template has the file name extension *.sta. Save with a 
recognisable name like A4 landscape 1 to 50.sta 
 
Note that although saved as a template – the picture being worked on will still be saved as an 
*.mcd file – look at the window header to check this. 
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2 Simple Drawing Techniques 

2.1 Handy Hints 
Remember if you accidentally move your page around when drawing you can click on “Page”, “Fit 
to Window” to re-centre it. If you accidentally draw something you don’t want use “Edit”, Undo” to 
get rid of it (or CTRL Z). 

2.2 Drawing a simple shape 
Start by selecting your template file (use the recent files list on the “File” menu) and saving the 
document as Example 2.mcd 
 
Make sure all the page is displayed through “Page”, “Fit to Window”. 
 
At the moment we will be working with no constraints on. This will be explained in more detail in a 
moment – but for the time being we need to turn all the constraints off.  
 
Open the “Constraints” palette (click on “Window”, “Palettes” and the palette appears). Make sure 
all the symbols are de-selected, by clicking on those with a square around them, then close the 
palette down. 
 
The tools down the LHS are now mainly for drawing different shapes, as well as selecting items, 
placing text and zooming in and out on your drawing. You need to keep an eye on which tool is 
selected (has the box round it) – otherwise you may accidentally zoom when you want to draw a 
circle or draw when you want to select!  
 
If you right click on a tool, a selection of similar tools are shown – e.g. double lines, regular 
polygons etc. Some useful tools are obtained by right clicking on the zoom tool  for example, 
the move page tool which allows you to move the sheet of paper behind your drawn object 
rather than move the object. 
 
Select the 6th picture down – the rectangle tool The cursor should change to a cross. 
Click and drag to draw a rectangle. 
 
Now look at the object information palette on the RHS of the screen – it gives data about the 
shape. 
 
The shape can be rescaled by typing the lengths of the sides into the ±X and ± Y boxes. 
 
The pattern of nine circles indicates where the fixed point will be when rescaling the shape: at a 
corner; in the middle of a side or in the centre of the shape. The co-ordinates of the point selected 
are also shown. 
 
Try rescaling the shape from different points to see how this works. 

2.3 Changing views 
You can zoom in and out on what you have drawn by using the zoom tool or using one of the 
small buttons seen in the very bottom left of the screen. Vectorworks also has the useful feature of 
being able to flip back and forward through previously selected views (bottom left arrows). 
 
Try zooming and paging through the views to see how this works. 
 


